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Amazon Pay - extension for Magento 1.x EU
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creativestyle is a leading e-commerce agency with offices in Germany and Poland. For more information, please visit https://www.creativestyle.de

Warning

This extension is not maintained anymore. Please use Amazon Pay (Checkout v2) [https://amazon-pay.rtfd.io/] instead.
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Warning

This extension is not maintained anymore. Please use Amazon Pay (Checkout v2) [https://amazon-pay.rtfd.io/] instead.




Overview

This extension provides an official integration of your Magento store with Login and Pay with Amazon services. They help your customers shop quickly, safely and securely. Your customers can pay on your website without re-entering their payment and address details. All Amazon transactions are protected by Amazon’s A-to-z Guarantee.

The extension is a pure payment solution. No item level is communicated to Amazon Payments and it allows you to manage your orders directly from Magento.


Getting the extension

This extension is not maintained anymore and isn’t available for the public download. Contact support in case you need to obtain the installation package of this extension.



Extension features


	Pay with Amazon button in the shopping cart and in the 1st step of OnePage checkout


	Login with Amazon button on the customer login and registration page


	Customization of Login and Pay with Amazon widgets from within Magento admin


	Support for payment authorizations, captures and refunds (also partial refunds)


	Support for synchronous and asynchronous authorization


	Supports Amazon Instant Payment Notifications


	Live & sandbox modes available


	Toolbox for simulating payment states in sandbox mode


	CSV-based event logger


	Multilanguage, available languages: en, de, fr, es, it






Extension vendor

This extension has been developed by creativestyle GmbH, a leading Magento agency [https://www.creativestyle.de/magento/], in cooperation with Amazon Payments Europe S.C.A.

Creativestyle is an award-winning, pioneering e-commerce agency with more than 15 years of experience. Since 2001, they have been developing expertise in the field of technology and software solutions. With a 50 person team of experts consisting of certified specialists in the fields of design, development and management of innovative projects, they can guarantee a full range of services from consulting and planning, through concept and design, to technical implementation and subsequent project support.


creativestyle GmbH

Erika-Mann-Straße 53

80636 München

Germany

https://www.creativestyle.de










          

      

      

    

  

    
      
          
            
  
Warning

This extension is not maintained anymore. Please use Amazon Pay (Checkout v2) [https://amazon-pay.rtfd.io/] instead.




Prerequisites


System requirements

Amazon Pay for Europe Magento extension requires you to have a valid Amazon Pay account (refer to the Amazon Pay and Login with Amazon account setup if you don’t have one yet) and a webserver running a Magento store instance with following conditions met:


	Magento CE (1.5, 1.6, 1.7, 1.8, 1.9) or EE (1.11, 1.12, 1.13, 1.14)


	cURL for PHP


	DOM / XML for PHP


	valid SSL certificate (for Login with Amazon and / or IPN handling)





Note

An additional fix needs to be installed for Magento 1.5. Please refer to the FAQ to get more details.





Amazon Pay and Login with Amazon account setup


Registering an Amazon Payments Account


	Go to:


	DE merchants: https://payments.amazon.de/preregistration/lpa [https://payments.amazon.de/preregistration/lpa?ld=SPEXDEAPAMagento]


	UK merchants: https://payments.amazon.co.uk/preregistration/lpa [https://payments.amazon.co.uk/preregistration/lpa?ld=SPEXUKAPAMagento]






	Click Sign Up ‣ I’m a merchant




[image: _images/prerequisites_screenshot_1.png]

	Go through the questionnaire to find out if you qualify for using Amazon Payments, then click Sign up now


	At the moment you cannot add your Login and Pay with Amazon account to an existing Amazon merchant account. You have to register a new account specifically for the Advanced Payments APIs.


	Start registering a new account:


	If you see the link Would you like to create a new account using a different e-mail address? Click here, please do so.


	Enter a name for your business. In case this name is already taken, please choose a different one.


	Enter an email address and a password. You should choose a role email address that will be read directly by the people responsible for the Amazon Payments integration. You should avoid general addresses like info@ that are only forwarded to the general administration.


	Choose a secure password.








[image: _images/prerequisites_screenshot_2.png]

	Please fill in all requested information about your seller account, your contact information and your bank account or credit card data.


	Please be careful to provide exact and correct data. All information you provide will be verified by Amazon Payments, and incorrect information will delay the verification process.




[image: _images/prerequisites_screenshot_3.png]

	After providing all information there will be an identity check on the phone, where you will be asked to enter a PIN.




[image: _images/prerequisites_screenshot_4.png]

	Afterwards you can complete your registration




[image: _images/prerequisites_screenshot_5.png]

	After your account is registered you will be forwarded to your Seller Central account.


	Please be aware that you cannot fully use your account yet. First you have to provide your identity data, and then the account has to go through the verification process.






Entering identity data in Seller Central

To get the verification process started, please log in to Seller Central: https://sellercentral-europe.amazon.com/gp/homepage.html

For a combined account (Login and Pay with Amazon added to an existing account), please make sure that you have selected the Amazon Payments – Production View in the drop down menu on the top.

[image: _images/prerequisites_screenshot_6.png]
At Settings ‣ Account Info please provide the requested missing information. Especially it is crucial to provide the ID information for all relevant persons.

[image: _images/prerequisites_screenshot_7.png]


Verification Process / Verification of all given information by Amazon Payments

After successful registration of the Amazon Payments seller account and entering the ID information Amazon Payments will check all information provided. Depending on the information provided Amazon Payments may request more information.



Creating MWS access keys

You can generate your MWS access keys in Seller Central. Please go to Integration ‣ MWS Access Key

[image: _images/prerequisites_screenshot_8.png]
[image: _images/prerequisites_screenshot_9.png]
Log in again with your Amazon Payments account credentials

[image: _images/prerequisites_screenshot_10.png]
Make sure that you register the MWS Access Key for your own account.

[image: _images/prerequisites_screenshot_11.png]
Please read and accept the license agreement.

[image: _images/prerequisites_screenshot_12.png]
The AWS Access Key and the Secret Key among with the Merchant ID, will be presented to you on the next page. You can always review the key information in Seller Central on the Integration ‣ MWS Access Key page.

[image: _images/prerequisites_screenshot_13.png]


Registering application for Login with Amazon service

Login and Pay with Amazon work together to provide a great buyer experience. To use Login with Amazon you have to register the application (Magento extension) that will be allowed to access buyers accounts through your Amazon Payments seller account. Login with Amazon configuration settings can be accessed through Integration Central in Seller Central.

[image: _images/prerequisites_screenshot_19.png]
On Integration Central page, scroll down to the ‘Manage client ID/store ID(s)’ sectionOn and register a new application by clicking the ‘Create new client ID/store ID` button at bottom.

[image: _images/prerequisites_screenshot_20.png]
On the Create new client ID/store ID form, add basic details about your web site. These details will be used on your website and mobile apps (if applicable).
.. image:: /images/prerequisites_screenshot_21.png


	Application or store name. This is the name displayed on the consent screen when the users agree to share the information with your web site. This name applies to website versions of your application.


	Description. A description of your web site for Login with Amazon users.


	Upload a logo. This logo will represent your business or website on Amazon. The logo will be displayed as a 150x150 pixel image; if you upload a file of a different size, it will be scaled to fit.


	Privacy policy URL. The Privacy URL is the location of your company privacy policy. It is also displayed on the consent screen. This link is displayed to users when they first login to your application (for example: http://www.example.com/privacy.html).


	Allowed JavaScript origins. The URL of your shop (for example: http://www.example.com). To add more than one origin (in case you are running domain based multi-store Magento installation and all stores are using the same Amazon Payments seller account), click Add another URL.


	Allowed return URLs. The Login with Amazon authorization service redirects users to this URL when they complete login (for example: http://www.example.com/amazonpayments/advanced_login/redirect/).




On top of the creativestyle plugin configuration page you can find the URLs that need to be added to the Create new client ID/store ID form mentioned before.
.. image:: /images/prerequisites_screenshot_22.png


Note

To use Login with Amazon with your Magento shop, you MUST specify an allowed JavaScript origin.





Where to find the required credentials to configure the Magento extension

Magento extension requires you to enter information about your Amazon Payments account. You will need to enter:


	Merchant ID (aka Merchant Number, Händlernummer, Händler-ID)





Note

The Merchant Token IS NOT Merchant ID.




	AWS Access Key (aka AWS Access Key ID, AWS-Zugangsschlüssel, AWS Zugangsschlüssel-ID)


	Secret Key (aka AWS Secret Key, geheimer Schlüssel)




For Login with Amazon service you will also need:


	Client ID




You can find this information in your Amazon Payments seller account in Seller Central [https://sellercentral-europe.amazon.com/hz/me/integration/details].

[image: _images/prerequisites_screenshot_191.png]


Configuration required in Seller Central

If you’re planning to use IPN for the post-payment processing you need to enter a Merchant URL (IPN endpoint URL) in Seller Central. You can do this at Settings ‣ Integration Settings, then click the Edit button at Instant Notification Settings. IPN endpoint URL can be obtained from Magento admin at System ‣ Configuration ‣ Amazon Payments, see: IPN endpoint URL.






          

      

      

    

  

    
      
          
            
  
Warning

This extension is not maintained anymore. Please use Amazon Pay (Checkout v2) [https://amazon-pay.rtfd.io/] instead.




Installation


Pre-installation steps


	Create a backup of your shop before proceeding to install.


	If your shop is using compilation (you can check it in System ‣ Tools ‣ Compilation), disable it please before proceeding to install.






Installation process


Installation via Magento Connect Manager


	Go to System ‣ Magento Connect ‣ Magento Connect Manager and enter your admin credentials to get logged in.




[image: _images/installation_step_1.png]
[image: _images/installation_step_2.png]

	In the Install New Extensions section enter the extension key and click Install button. Magento Connect Manager will validate the key and check the extension dependencies and will display a pre-installation summary. Click Proceed button to start the installation.




[image: _images/installation_step_3.png]

	After the successful installation, please click on Refresh button to refresh the list of the installed extensions and assure that Login and Pay with Amazon (identified as Creativestyle_AmazonPayments) is listed on that list.




[image: _images/installation_step_4.png]

	Proceed to the Post-installation steps.






Manual installation


	Contact support to obtain a copy of the installation package of this extension. Unpack the received file to your Magento root directory.





Note

If you are using any VCS (git, svn, mercurial) for versioning your shop basecode, you can also commit the content of the received file to the VCS repository and next deploy it to your shop.




	Proceed to the Post-installation steps.







Post-installation steps


	If you’re using custom design theme, refer to the Templates customization section to find out how to adjust Login and Pay with Amazon templates to your needs.


	Go to System ‣ Cache Management and flush Magento cache storage.


	If you have disabled compiler in pre-installation stage, you can go now to System ‣ Tools ‣ Compilation, recompile and enable compiler again.


	Logout from the Magento admin and login again.




Voila! The Login and Pay with Amazon extension shall be installed now. You can proceed to the Configuration followed by Frontend templates and Email templates customization (if applicable).



Upgrade


Pre-upgrade steps


	Create a backup of your shop before proceeding to upgrade.


	If your shop utilises compilation (you can check it in System ‣ Tools ‣ Compilation), disable it please before proceeding to upgrade.






Migrating from Magento Connect / Marketplace


	Go to System ‣ Magento Connect ‣ Magento Connect Manager and enter your admin credentials to get logged in.




[image: _images/installation_step_1.png]
[image: _images/installation_step_2.png]

	On the list of the installed extensions please find Creativestyle_AmazonPayments, select Uninstall in the corresponding action dropdown list and click Commit changes button.


	After the successful uninstallation from the previous source, install it as described in the Installation via Magento Connect Manager section.






Upgrade process


	Go to System ‣ Magento Connect ‣ Magento Connect Manager and enter your admin credentials to get logged in.




[image: _images/installation_step_1.png]
[image: _images/installation_step_2.png]

	Click Check for Upgrades button in the Manage Existing Extensions section. If the newest version of Amazon Pay is available, the Creativestyle_AmazonPayments extension on the list will be highlighted with the yellow color. In the corresponding action dropdown list please select Upgrade to X.X.X (stable) option and click Commit changes button.


	After the successful upgrade, please click on Refresh button to refresh the list of the installed extensions and assure that Login and Pay with Amazon (identified as Creativestyle_AmazonPayments) was upgraded to the desired version.


	Proceed to the Post-upgrade steps section.






Post-upgrade steps

Version 3.0.2 comes with a significant change to the payment processing workflow (comparing to versions 1.x and 2.x). Prior to version 3.x the payment authorization was requested during placing the order (i.e. right after clicking Save order button in the checkout), thus in synchronous and optimized authorization mode (assuming there wasn’t transaction timed out error), the order ended up with the immediate authorization result.

Since the Strong Customer Authentication (derived from the PSD2 directive) was introduced in version 3.0.2, the authorization is requested after the order is actually placed. Thus, it may happen that the order payment remains unauthorized for a longer time unless the buyer finishes his Multi-Factor Authentication challenge. This change has to be considered for passing the order to the fulfillment process, to avoid fulfilling the orders that haven’t been actually paid. As stated in Payment authorization section, it is always advised to start fulfilling the order after the authorization is confirmed, which, in the default configuration, is reflected by the “Processing” order status.



Upgrade to 3.x troubleshooting

After upgrade to 3.x, when the buyer clicks Amazon Pay button in the cart, he is redirected to the customer dashboard instead of the checkout.


	Please make sure that your webserver serves the most recent version of the js/creativestyle/amazonpayments.min.js file. Some webservers (as well as CDNs) are caching static assets, so it may happen that your shop serves an outdated version of the frontend JS application.


	If you are using custom layout or template files for Amazon Pay, make sure that your customizations are compliant with the recent changes in the extension. The easiest way to check is your customization is the case is to delete following files as after refreshing Magento cache, see if this resolves your issue:





	app/design/frontend/CUSTOMPACKAGE/CUSTOMTHEME/layout/amazonpayments.xml


	app/design/frontend/CUSTOMPACKAGE/CUSTOMTHEME/template/creativestyle/amazonpayments/js.phtml


	app/design/frontend/CUSTOMPACKAGE/CUSTOMTHEME/template/creativestyle/amazonpayments/login/redirect.phtml









          

      

      

    

  

    
      
          
            
  
Warning

This extension is not maintained anymore. Please use Amazon Pay (Checkout v2) [https://amazon-pay.rtfd.io/] instead.




Configuration

After the successful installation you can proceed to the configuration. In Magento admin go to creativestyle ‣ Amazon Pay and Login with Amazon ‣ Settings (or System ‣ Configuration ‣ Amazon Payments tab).

[image: _images/configuration_screenshot_1.png]
Available options are grouped in following sections:

[image: _images/configuration_screenshot_10.png]

Amazon Payments Account

In this section you can define your Amazon Payments seller account credentials.

[image: _images/configuration_screenshot_2.png]

Merchant ID, Access Key ID, Secret Access Key

Fill out those fields with your Amazon Payments seller credentials. You can find them in the Amazon Seller Central, see: Where to find the required credentials to configure the Magento extension.



Marketplace

Select the country where you registered your seller account from the provided drop-down list. If you’re unsure about this information consult your Amazon Integration Assistant.



Validate Amazon Payments account

This button is designed to validate your Amazon Payments account credentials. Please use it to check whether your credentials (Merchant ID, Access Key ID, Secret Access Key and Marketplace) are valid or not.


Warning

Please note that the above feature will validate ANY Amazon MWS account, also such one that is not registered to Amazon Payments.








General Settings

In this section you can enable or disable the Pay with Amazon service and define basic settings of the extension.

[image: _images/configuration_screenshot_3.png]

Enable Pay with Amazon

By switching this option you can enable or disable Pay with Amazon. This option must be set to Yes if you want to provide the Pay with Amazon service to your customers.



Sandbox mode

Sandbox mode has been designed to test the Pay with Amazon service. In sandbox mode the selected payment method is not charged. Refer to the Pay with Amazon documentation to get more information about the sandbox environment. In general, sandbox mode should be enabled for development and staging environments for testing and always has to be disabled for production environments. Never show the sandbox buttons and widgets to buyers in your live environment.



Show Sandbox Toolbox

In sandbox mode you can simulate certain states for the different objects in the payment process. By enabling this option you get additional fields on the Amazon Checkout page that allow selecting expected payment statuses for orders, authorizations, captures and refunds returned in responses. This feature allows you to simulate different scenarios including declines in the sandbox environment.



Payment Action

You can select the desired payment action taken after an order is placed. Available options are:


	Manual authorization - the order reference is created only. Authorization must be requested manually by clicking Authorize button on the order preview page in Magento admin.


	Authorize (default) - order reference creation is followed by automatic authorization request. Capture must be requested manually by creating an invoice with Capture online option selected.


	Authorize & capture - order reference creation is followed by automatic authorization and capture request.


	ERP mode - same as Manual authorization, but further payment processing (authorization, capture, IPN notifications handling) is blocked in Magento. In this mode, it is assumed that after order reference creation rest of the payment processing steps will be handled by merchant’s external ERP system.





Warning

Please do not use ERP mode unless your ERP system supports Amazon Payments transactions processing.





Authorization Processing Mode

This option defines mode of calling authorization request. By default Asynchronous mode is set, meaning that the Amazon Payments API responses immediately, but the authorization status is not known exactly and thus returned as Pending. This behavior requires authorization status update (either via IPN notification or cron-triggered data polling) before dispatching the order. Synchronous authorization returns its status immediately, but such a process takes usually few seconds more than Asynchronous authorization, causing your customer needs to wait longer until success page appears after Place order button click.



Enable Instant Payment Notifications

This option enables or disables handling of Instant Payment Notifications, which are used by Amazon Payments for sending feedback concerning the status of payment objects. Keep in mind that using IPN requires valid SSL certificate (issued by a trusted CA) installed on your server and correctly configured Secure Base URL and Use Secure URLs in Frontend config options (System ‣ Configuration ‣ Web ‣ Secure section). In case you disable IPN and want to use data polling instead you need to setup a cron for your shop.


Note

Trusted Certificate Authorities and other SSL requirements are listed on Amazon Payments webpage in english [https://payments.amazon.co.uk/help/81779] and german [https://payments.amazon.de/help/81779] language.





IPN endpoint URL

This auto-generated value shall be entered in the Merchant URL field of the Integration Settings in your Amazon Seller Central in case you plan to use IPN. If you use more than one store view in your Magento installation, the IPN endpoint URL will be shown after selecting appropriate store view scope.



Data polling frequency

If you don’t have a valid SSL certificate in your shop or due to any other reason you don’t want to use IPN, you can set how often status of the different object shall be polled from Amazon Payments servers. Note that the cron must be setup for your shop for periodic triggering routines that poll payment data.



New order status

With this option you can choose the status for newly created orders. Statuses assigned to New state are allowed only. Please note that this config option becomes obsolete when you use synchronous authorization, initial order status will be set to Order status on authorization value then.



Order status on authorization

With this option you can change the status that will be set for an order after a successful authorization. Statuses assigned to Processing state are allowed only. In most cases leaving the default value seems to be a good idea.


Warning

Please note the difference between state and status terms in Magento. State is used by Magento internally to identify current stage of the order workflow, while status is some kind of a descriptive reflection of the state for seller purposes. Just as it is not possbile to define custom states in Magento, it is not possible to configure the extension to use different order states as well (New aka Pending is used for newly created orders, Processing - for successfully authorized orders). This rule implies that New order status can be only changed to the status that is assigned to New state, while Order status on authorization to the status assigned to Processing state. Any attempt to modify this behavior in the extension source code directly may lead to the inconsistency of the order workflow and may cause hard to debug issues. In case you need different than New state for the newly created order, consider using synchronous authorization which gets authorization status immediately and uses Order status on authorization straight away.








Login with Amazon

In this section you can configure Login with Amazon service.

[image: _images/configuration_screenshot_7.png]

Enable Login with Amazon

By switching this option you can enable or disable Login with Amazon feature. This service must be enabled if you want to create customer accounts in your Magento shop when order is placed and to make sure that any of the orders paid with Pay with Amazon will be never a guest order.



Client ID

The Client ID identifies your website for Login with Amazon service. Please refer to Where to find the required credentials to configure the Magento extension section to find out how to get the value of your Client ID.



Display Language

In this option you can select a language which will be used for displaying all elements (froms, widgets) generated by Amazon Payments. Selected language will be also used to localize emails sent by Amazon Payments to the customer after purchase. This setting applies also to Pay with Amazon as long as Login with Amazon is enabled.



Authentication Experience

Select the method the authentication will be processed. By default Pop-up is used, meaning that after pressing Pay or Login with Amazon button, new window with Amazon login form opens, this requires the page you are placing the buttons on to be SSL-secured though. Choosing Redirect experience your customers will be redirected to Amazon login form in the current window after pressing Pay or Login with Amazon button. For the Redirect experience it is required to set Allowed Return URLs in the Login with Amazon section in your Seller Central.


Warning

Be aware that Pop-up authentication experience used by default requires the page, the button is placed on, to be in the SSL mode. This requirement is fulfilled by switching the cart page into SSL on the fly. This may lead to the unexpected results, especially if you are using some non-default Magento extensions (eg. AJAX-based adding to cart). It is always advised to test the extension in the staging environment prior to the production deployment.








Email Options

[image: _images/configuration_screenshot_4.png]

Send order confirmation

This option allows you to select whether a confirmation email for newly placed orders shall be sent by the shop. Note that, regardless this setting, a payment confirmation will be always sent by Amazon Payments.


Note

Order confirmation emails are not sent unless authorization is confirmed. If the emails are not sent, even you have above option enabled, it is very likely that Amazon Payments transactions are not updated. In such a case please make sure your shop accepts IPN notifications or polls transaction data in the cronjob.





Declined Payment Email Template

In this option you can select an email template which will be used for notifying customers about declined authorizations. Refer to the Email templates section to find out how to customize email templates.



Declined Payment Email Sender

With this option you can define the sender of the Authorization declined email notification. The sender can be selected from the pre-defined Magento email contacts (System ‣ Configuration ‣ Store Email Addresses).






Common Appearance Settings

In this section you can set size (width and height) of Amazon widgets used in the checkout process.

[image: _images/configuration_screenshot_5.png]

Use responsive widgets

With this option you can decide if Amazon widgets used in the checkout (address book, wallet) will adapt to the layout by filling whole container area. This behavior allows to set widget size by defining size of its container in the external CSS file, making Amazon checkout compatible and easy to use with responsive layouts. Disabling this option will change the widgets to use explicit sizes defined in the next config options of this section.



Address widget width, Address widget height

In this option you can set size in pixels (width and height) of Amazon address book widget for disabled Use responsive widgets option.



Wallet widget width, Wallet widget height

In this option you can set size in pixels (width and height) of Amazon wallet widget for disabled Use responsive widgets option.






Alexa Delivery Notifications

Alexa delivery notifications for Amazon Pay merchants allow you to pro-actively inform your customers if their order is on its way or has arrived.
After enabling the feature, you will need to get your Public Key ID to be able to interact with the Amazon Pay Delivery Tracker APIs. To do so, please follow the instructions given in this guide [https://developer.amazon.com/de/docs/amazon-pay-automatic/delivery-notifications.html#get-your-public-key-id].

Once done, you will have your Private Key and Public Key ID. Please enter them into the corresponding fields. If your version still has a Public Key field, please simply ignore it and continue.

[image: _images/configuration_screenshot_101.png]
Configure your carriers using the Carrier codes form by selecting your available carriers and assign them to the matching one in the Amazon Pay carrier list.

[image: _images/configuration_screenshot_11.gif]
Save your work and you are done. To verify, if everything is working as expected, simply mark an AmazonPay order as shipped and add a tracking code to the shipment. The API Log should show a successfull delivery tracker request (Status Code: 200).





Appearance Settings for Login and Pay with Amazon

These settings apply to the design (type, size and color) of the buttons, both Pay with Amazon and Login with Amazon, when Enable Login with Amazon option is set to Yes, therefore they become irrelevant if you don’t use Login with Amazon service, you may be interested then in Appearance Settings for standalone Pay with Amazon.

[image: _images/configuration_screenshot_8.png]




Appearance Settings for standalone Pay with Amazon

These settings apply to the design (size and color) of the Pay with Amazon button when Enable Login with Amazon option is set to No, therefore they become irrelevant if you use Login with Amazon service, Appearance Settings for Login and Pay with Amazon are applied then.

[image: _images/configuration_screenshot_9.png]




Developer options

[image: _images/configuration_screenshot_6.png]

Allowed IPs (comma separated)

For testing or debugging purposes you can restrict access to Pay with Amazon checkout in your shop to certain IP numbers only. Pay with Amazon button will be shown only for the visitors coming from allowed IPs. You can set more than one allowed IP separated with commas.



Enable logging

The Pay with Amazon extension comes with a dedicated logging mechanism. Any exception, API call or IPN notification will be saved to the var/log/amazonpayments folder in your Magento installation. For your convenience logs are also accessible via creativestyle ‣ Login and Pay with Amazon ‣ Log preview in Magento admin. Refer to the Event logs section to get more details concerning the logging feature.






          

      

      

    

  

    
      
          
            
  
Warning

This extension is not maintained anymore. Please use Amazon Pay (Checkout v2) [https://amazon-pay.rtfd.io/] instead.




Design customization


Frontend templates

If you are using a custom design theme and would like to adjust the appearance of Login and Pay with Amazon templates, please complete the following steps (all paths are relative to the Magento root folder):


Warning

Never edit the default template or skin files directly as they can be (and surely will be) overwritten when upgrading this extension to a newer version. Edit their copies only as described below.




	Create folders:

app/design/frontend/YOURPACKAGE/YOURTHEME/template/creativestyle/amazonpayments
skin/frontend/YOURPACKAGE/YOURTHEME/creativestyle/css
skin/frontend/YOURPACKAGE/YOURTHEME/creativestyle/images

On Unix-like (Linux, BSD) servers you can achieve this by running following commands, please remember to replace YOURPACKAGE and YOURTHEME with the real names of your theme:


$ cd /path/to/your/Magento
$ mkdir -p app/design/frontend/YOURPACKAGE/YOURTHEME/template/creativestyle/amazonpayments
$ mkdir -p skin/frontend/YOURPACKAGE/YOURTHEME/creativestyle/css
$ mkdir -p skin/frontend/YOURPACKAGE/YOURTHEME/creativestyle/images










	Clone the following files:

app/design/frontend/base/default/layout/amazonpayments.xml
app/design/frontend/base/default/template/creativestyle/amazonpayments/*
skin/frontend/base/default/creativestyle/css/amazonpayments.css
skin/frontend/base/default/creativestyle/images/*

On Unix-like (Linux, BSD) servers you can achieve this by running following commands, please remember to replace YOURPACKAGE and YOURTHEME with the real names of your theme:


$ cd /path/to/your/Magento
$ cp app/design/frontend/base/default/layout/amazonpayments.xml app/design/frontend/YOURPACKAGE/YOURTHEME/layout/amazonpayments.xml
$ cp app/design/frontend/base/default/template/creativestyle/amazonpayments/* app/design/frontend/YOURPACKAGE/YOURTHEME/template/creativestyle/amazonpayments/*
$ cp skin/frontend/base/default/creativestyle/css/amazonpayments.css skin/frontend/YOURPACKAGE/YOURTHEME/creativestyle/css/amazonpayments.css
$ cp skin/frontend/base/default/creativestyle/images/* skin/frontend/YOURPACKAGE/YOURTHEME/creativestyle/images/*












After cloning the above files to your theme folders, you can adjust the design by editing the appropriate files (HTML templates, CSS stylesheets and layout file). You can enable Template Path Hints to find out the names of the template files used by the extension in particular steps of the checkout process (in Magento admin, within selected store view scope: System ‣ Configuration ‣ Developer ‣ Debug).

[image: _images/customization_screenshot_1.png]

Note

Please note that the ID attributes of all HTML tags must be preserved, otherwise changes to the corresponding JS scripts must be applied (do not try to change it unless you know what are you doing).



Basic appearance of rendered Amazon widgets (button color and size of all widgets) can be set in the Pay with Amazon extension settings (System ‣ Configuration ‣ Amazon Payments), see Common Appearance Settings, Appearance Settings for Login and Pay with Amazon and Appearance Settings for standalone Pay with Amazon for more details.



Amazon Payments logo

If you want to place the Amazon Payments logo in your shop to let your customers know you’re using payment services provided by Amazon Payments refer to the following guidelines:


	logos:


	UK: https://payments.amazon.co.uk/merchant/tools#marks


	DE: https://payments.amazon.de/merchant/tools#marks






	button placement:


	UK: https://payments.amazon.co.uk/merchant/tools#guidelines


	DE: https://payments.amazon.de/merchant/tools#guidelines








To complement the logos you should mention Amazon Payments under your listing of supported payment methods.



Email templates

Magento provides an easy-to-use mechanism for adjusting email templates’ appearance and content. If you want to customize the emails that are sent by the extension, go to System ‣ Transactional Emails in your Magento admin and follow the instructions:

[image: _images/customization_screenshot_2.png]
On the Transactional Emails list press Add New Template button and the form will appear. In the Load default template section choose Amazon authorization declined from the Template dropdown, change Locale, if needed, which will be used for the loaded template pattern (Pay with Amazon extension provides 3 locales: German, English UK and English US, for any other locale selected, the english (US) template will be loaded) and press Load Template button.

[image: _images/customization_screenshot_3.png]
Fields in Template Information section will be filled out with the data taken from the default email template. Please fill in the missing name of your modified email template in the Template Name input, adjust Template Content and Template Styles to your needs and save your work by pressing Save Template button. The new template shall appear on the Transactional Emails list.

The newly created email template can be used now, you can switch to it in the extension settings, see: Declined Payment Email Template.





          

      

      

    

  

    
      
          
            
  
Warning

This extension is not maintained anymore. Please use Amazon Pay (Checkout v2) [https://amazon-pay.rtfd.io/] instead.




Login with Amazon

Login with Amazon allows users to login to your shop using their Amazon user name and password. All available data needed for creating an account or placing an order in your Magento shop (including name, email address, and zip code) are fetched automatically from customer’s Amazon account.


Requirements

Login with Amazon service requires you to have a valid Login and Pay with Amazon account (refer to the Amazon Pay and Login with Amazon account setup if you don’t have one yet), registered application for Login with Amazon service (refer to the Registering application for Login with Amazon service if you don’t have one yet) and Magento store with a valid SSL certificate installed and properly configured in your shop. By “installed and properly configured SSL certificate” it is meant that your webserver is configured to serve pages via HTTPS protocol, Base URL config option is set to the HTTPS-based URL and in Web ‣ Secure section of Magento settings.



Login with Amazon button

The Login with Amazon button appears in several places in the shop:


	on the customer login page,


	on the customer registration page.




[image: _images/login_screenshot_1.png]
You can also place the Login with Amazon button in any place you like by including following statement in the template file:

<?php echo Mage::helper('amazonpayments')->getLoginWithAmazonButton(); ?>





Pressing the Login with Amazon button launches the Amazon authentication window, where the customer is asked for his Amazon account e-mail address and password.

[image: _images/order_step_2.png]
After a successful login the customer is redirected to the user area in your shop.


Note

When the customer uses the Login with Amazon for the first time in your shop and account with the same e-mail address already exists in your shop, he will be asked to enter his shop password to match both shop and Amazon accounts. Moreover, if you require additional data from your customers which cannot be provided by Amazon (like date of birth or gender), the customer will be asked for those data in a dedicated form, that appears after the first use of Login with Amazon button.







          

      

      

    

  

    
      
          
            
  
Warning

This extension is not maintained anymore. Please use Amazon Pay (Checkout v2) [https://amazon-pay.rtfd.io/] instead.




Order & payment workflow

The Login and Pay with Amazon extension follows the standard Magento order and payment workflow, and thus processing Pay with Amazon payments doesn’t differ significantly from other payment methods available in Magento, making it easy to handle. The most important difference, comparing to the standard Magento orders, is delayed access to the billing address, which is backfilled later in the synchronization process after the successful authorization.

All Amazon payment objects (OrderReference, Authorize, Capture and Refund) are reflected in corresponding payment transactions in Magento, which are connected with appropriate document entities provided by the Magento, (invoices for captures, credit memos for refunds).


Pay with Amazon button

The Pay with Amazon button appears in several places in the shop:


	on the shopping cart page,


	in the 1st step of the default One Page Checkout,


	in the sidebar cart widget.




[image: _images/order_step_1.png]
You can also place the Pay with Amazon button in any place you like by including following statement in the template file:

<?php echo Mage::helper('amazonpayments')->getPayWithAmazonButton(); ?>





Pressing the Pay with Amazon button launches the Amazon Payments authentication window, where the customer is asked for his Amazon account e-mail address and password.

[image: _images/order_step_2.png]
After a successful login the customer is redirected to the Amazon checkout page in your shop.



Placing an order

The Pay with Amazon checkout form consists of 4 steps arranged within a single page (unlike Magento default checkout, which uses accordion for showing and hiding particular steps of the checkout). These steps are: shipping address (handled by Amazon’s address book widget), payment method (handled by Amazon’s wallet widget), shipping method and order review (handled by default Magento checkout templates). All fields in the form (shipping address, payment method and shipping method) are pre-filled, which means that in very basic scenario customer can finish the checkout with just one click. Unfortunately, pre-filling doesn’t apply to the terms and conditions checkbox (if used at all) and can raise the number of required clicks, which, however, doesn’t affect the easiness and user-friendliness of the Pay with Amazon payment method.

[image: _images/order_step_3.png]

Note

The value selected in each checkout step is saved in a separate AJAX call. When the checkout form shows up for the first time, depending on the internet connection speed  and the web-server’s response time, it may take up to few seconds until Place order button gets active and can be clicked by the customer.



After selecting the desired shipping address, payment method, shipping method and pressing Place order button (preceded by accepting terms and conditions if needed), the customer is redirected to the success page. Pay with Amazon uses the default Magento success page, which means there’s no need to add any tracking scripts or additional page layout elements that you use in default Magento checkout and want also use in Amazon checkout, all features implemented additionally on the Magento success page shall also appear on Amazon checkout success page.

[image: _images/order_step_4.png]
The created order will be transferred to Amazon and will appear in your Magento admin in Pending (by default) or Processing (if you are using synchronous authorization) state.


Note

You may notice in the Magento admin that the billing address may be incorrect at this point (as mentioned in the introduction to this chapter). That’s true if the billing differs from the shipping data. The only available payment object at the time of placing order is the OrderReference, which, unfortunately, doesn’t provide billing data and thus shipping address must be used to meet Magento requirements concerning order data. The billing address will be updated as soon as authorization is confirmed by Amazon Payments. Keep also in mind that the billing address is available only for the sellers that provided a valid VAT number in Amazon Seller Central.





Multicurrency support

Amazon Pay extension supports multicurrency payments on the website level. Website is the top level organizational unit in Magento, it may share customer accounts, shipping and payment methods. To offer multicurrency support that is provided by Amazon Pay service in your Magento shop, you have to create a separate website for each currency you plan to offer in your shop, with the selected currency set as a base currency in Magento settings.

[image: _images/multicurrency_websites.png]
By default the base currency is set globally in Magento, to make it available on the website level, please go to System ‣ Configuration ‣ Catalog ‣ Catalog ‣ Price ‣ Catalog Price Scope and set its value to Website.

[image: _images/catalog_price_scope.png]
Next go to System ‣ Configuration ‣ General ‣ Currency Setup ‣ Currency Options ‣ Base Currency and set its value to the selected currency for each of the websites you created previously to offer multicurrency support for your customers. The website configuration scope can be changed by selecting appropriate entry in the Current Configuration Scope dropdown list in the top right corner of the configuration page.

[image: _images/website_currency_setup.png]

Note

Please note, that multicurrency support in the extension doesn’t use Display Currency setting, which may be set on the store view level. Display currency is used just for the storefront presentation purposes and doesn’t play any role in further order post-processing, because all transactions are processed using base currency. Such a behavior is implemented in Magento core classes and Amazon Pay extension do not break this rule.





Payment authorization

An authorization can be requested after the order data is successfully transferred to Amazon. Depending on the value you’ve selected for Payment Action option it can be processed in several ways. For Authorize and Authorize & capture actions it will be requested automatically as soon as order is placed in your shop and successfully transferred to Amazon. The requested authorization will be therefore either confirmed or declined by Amazon either via IPN message or via data polling, see Synchronizing order data to get more details. The order, for which a payment authorization has been confirmed changes its state to Processing, an order email confirmation is sent to the customer (if not disabled in the extension settings, see Send order confirmation) and you can start the fulfilment process.


Warning

Never dispatch ordered items before the authorization is confirmed. Only the confirmed authorization guarantees that you will be able to capture the order amount (if you capture within 7 days).




Manual authorization

In case you ship ordered items after 30 days or more you have to select Manual authorization as a payment action. It will stop Magento from requesting an authorization automatically and let you make an authorization request manually from the Magento admin at any suitable time. To manually invoke an authorization, login to the Magento admin, open the order you want authorize payment for and click the Authorize payment button placed in the top buttons rows.

[image: _images/workflow_screenshot_3.png]
Next post-request processing (authorization confirmation or decline) is processed in the same way as in automatic authorization (through polling or IPN).



Declined authorizations

If the authorization is declined by Amazon due to problem with the payment method selected, your customer will be informed about this case via e-mail and requested to visit the Amazon Payments web site. The customer can on this page update the payment method by following the instructions on the web page. The e-mail sent to the customer can be adjusted according to the Email templates section. After the successful payment method update, Amazon will notify Magento about the new authorization status and payment will get back on the track (via polling or IPN).

In case the authorization has been declined due to any other reason then problems with the selected payment method, the notification email will be sent to shop administrator and appropriate action must be undertaken according to the Amazon Payments Integration Guide.




Capturing the payment amount

After a successful authorization, you can capture funds against the authorization. The capture, similar to the authorization, can be requested in two modes: manual and automatic. By default you should capture the order amount at the moment you ship the ordered items by creating an invoice. You are only allowed to enable automatic capture if you sell digital goods or you ship items the same day they are ordered. Moreover you have to be white-listed by Amazon Payments. Contact Amazon Payments if you want to use this option.

Payment Action option in the extension settings allows to switch between manual and automatic capture mode. For Manual authorization & Authorization actions the capture is triggerd by creating manually an invoice for the order in the Magento admin. For Authorize & capture action, the capture is requested automatically as soon as authorization is confirmed by Amazon Payments.


Manual capture

To capture the order amount, you must create an invoice first. To create an invoice, login to the Magento admin, open the order for which you want to capture the amount and click the Invoice button located in the top buttons rows. Please make sure that the order you want to process has been successfully authorized, which basically means that it is in Processing state.

[image: _images/workflow_screenshot_4.png]
After clicking the Invoice button, a new invoice form will appear with most of the crucial data (like products quantity) already filled in. You can adjust some invoice fields if needed. At this point you can create a shipment as well, by checking Create Shipment checkbox and adding a tracking number if needed. Before submitting the form, please make absolutely sure that Amount selectbox is set to Capture online and press Submit Invoice button. A new invoice and a new shipment (if checked Create Shipment checkbox) will be created for the order and the capture request is sent to Amazon Payments.

[image: _images/workflow_screenshot_5.png]

Warning

To collect the funds that were authorized, you must capture the amount within 30 days of a successful authorization (two days in Sandbox mode). We strongly recommend that you capture funds within seven days of authorization to reduce the likelihood of declines (within 7 days the a successful captures is guaranteed). In case your fulfilment process exceeds 30 days, consider using the Manual authorization as payment action in the configuration and authorize the payment later in any suitable time (typically in the week before the shipping) before the shipping.




Note

Partial captures are not supported by the extension at this moment.



The capture status, similar to authorizations, will be updated either via IPN message or via data polling, see Synchronizing order data for more details.



Automatic capture

In this mode the capture is requested automatically after the successful authorization. Also the invoice that covers all ordered items is created automatically. Post-request processing (capture status synchronization) is carried the same way as in capture invoked manually from Magento backend.




Refunding order items

The order, which payment has been captured for, can be refunded either fully or partially. Refunds are made against the invoices and thus having a paid invoice assigned to the order is a necessary condition that has to be met to refund any order item. Refunds in Magento are recorded as credit memos, so for requesting a refund with Amazon Payments you should create a credit memo first. To create a credit memo login to the Magento admin, open the order you want refund, click Invoices tab on the right, select an invoice you want to refund and click on it.

[image: _images/workflow_screenshot_6.png]
A preview of the selected invoice will appear. Make sure that you are on the single invoice preview page and click the Credit Memo button.

[image: _images/workflow_screenshot_7.png]
A new credit memo form will appear with most of the crucial data (like products quantity to be refunded) already filled in. If you want to refund the invoice partially (i.e. only a part of the invoiced items) adjust the product quantities to be refunded (set 0 for items that shall not be refunded) and click Update Qty’s button to update refund totals. You can also set the refunded items back to stock by checking Return to Stock checkbox. Next choose if you want to refund shipping costs or apply any refunds adjustment and fill in the appropriate fields. Next before submitting the credit memo form, double check that you have Refund button available and click it. A credit memo will be created and a refund will be requested with Amazon Payments. Its status will be updated either via IPN or data polling, depending on the update method selected in the extension settings.

[image: _images/workflow_screenshot_8.png]

Warning

For the successful refund (recorded in Magento and requested (!) with Amazon Payments) always use Refund button available on the new credit memo form invoked from the single invoice preview page. If you click Credit Memo button directly on the order page you will be redirected to the new credit memo form with Refund offline button only, which admittedly will record credit memo in Magento, but surely won’t call refund request at Amazon Payments gateway. If in any case you will get a credit memo with Refund offline button only then surely something had to go wrong and you should stop the refund process immediately and start it from the beginning following the above guideline.





Cancelling an order

For a variety of reasons it sometimes becomes necessary to cancel an order. To cancel an order and notify Amazon about the payment cancellation:


	Please make sure the amount of the order you want to cancel hasn’t been captured yet,


	Go to Sales ‣ Orders and select the order that you would like to cancel by clicking the Edit button on its respective row,


	Click Cancel in order page to remove this order.




[image: _images/workflow_screenshot_9.png]


Synchronizing order data





          

      

      

    

  

    
      
          
            
  
Warning

This extension is not maintained anymore. Please use Amazon Pay (Checkout v2) [https://amazon-pay.rtfd.io/] instead.




Testing your integration

After a successful configuration, you should test your installation. Only after successfully testing in the Sandbox mode you should switch to the live environment and make the button visible for all your sellers.

These tests should cover the different workflow that you encounter while processing orders. Both include the standard process like receiving an order, invoicing, shipment and alternative processes like canceling orders and refunding orders. Verify that all objects in your Magento admin are in the expected status and you correctly received all order information including the shipping address, contact details and the billing address (if applicable).

Next you should test also declines. You can use the Sandbox Toolbox to simulate soft and hard declines of authorizations. After your testing verify the log files to make sure no exceptions have occurred.

To receive the complete testing scenarios contact Amazon Payments.


How to create Sandbox test account

To use the sandbox environment, you need to create specific test accounts for the sandbox environment.


	Login into Seller Central [https://sellercentral-europe.amazon.com].


	Choose the menu Integration ‣ Test accounts.




[image: _images/testing_screenshot_1.png]

	Click on Create a new test account.




[image: _images/testing_screenshot_2.png]

	Fill in the form using a valid email address. The account can be used immediately after the account creation.




[image: _images/testing_screenshot_3.png]

	Add other delivery addresses to the test account (optional).




[image: _images/testing_screenshot_4.png]




          

      

      

    

  

    
      
          
            
  
Warning

This extension is not maintained anymore. Please use Amazon Pay (Checkout v2) [https://amazon-pay.rtfd.io/] instead.




Frequently Asked Questions


Installation

I have successfully installed Login and Pay with Amazon extension, but when I try to go to the configuration page System ‣ Configuration ‣ Amazon Payments I am getting: 404 Not Found error.

It’s a Magento bug, the ACL list is not reloaded after the new extension is installed. To solve this issue please logout from the Magento admin and next login again.



It is stated that the extension is compatible with Magento 1.5, but when I try to place an order I am getting an exception: Invalid method Mage_Sales_Model_Order_Payment::lookupTransaction().

Magento 1.5 doesn’t provide public wrapper for _lookupTransaction() method of order payment model, which is commonly used by Pay with Amazon extension. To fix this issue we have prepared a compatibility pack that rewrites current sales/order_payment model. You can install it via Magento Connect, to do so go to System ‣ Magento Connect ‣ Magento Connect Manager, enter your admin credentials to get logged in, in the Install New Extensions section enter http://connect20.creativetest.de/Creativestyle_AmazonPaymentsCompatibilityPack key and click Install button.


Warning

Keep in mind that if any other 3rd party extension rewrites the sales/order_payment model as well, installing Magento 1.5 Compatibility Pack may lead to a rewrite conflict resulting in misfunction of one or more extensions. It is always advised to test it on a staging system prior to deploy to the production.





Frontend

How can I disable Pay with Amazon for certain products?

There are few extensions available for disabling payment methods on-the-fly based on the desired conditions. We recommend to install and use Rico Neitzel’s PaymentFilter for Products and Customer Groups [http://www.magentocommerce.com/magento-connect/paymentfilter-for-products-and-customer-groups.html], which Pay with Amazon has been successfully tested against.



Pay with Amazon button doesn’t show up in the cart after the extension is installed and set up.

Lack of Pay with Amazon button in the cart is usually caused by one of the following reasons:


	incorrect Merchant ID set (double check if you don’t have any whitespaces in your Merchant ID),


	incorrect Marketplace set,


	your Amazon seller account is either blocked or not activated (you can check status of your account in Amazon Seller Central).




You can check validity of the provided Amazon Payments credentials using Validate Amazon Payments account button available in the extension settings. In case you are sure you have Merchant ID and Marketplace correctly set, check if any of the following extensions is installed and enabled in your shop and follow the instructions:


	Mxperts_NoRegion


	FME_Ajaxaddtocart




Those extensions replace default checkout.cart block with own ones. The replaced block doesn’t include checkout buttons defined previously. To bring the Pay with Amazon button back, find appropriate layout file:


	noregion.xml for Mxperts_NoRegion extension,


	ajaxaddtocart.xml for FME_Ajaxaddtocart extension




in your theme folder (or in the default theme folder) and modify checkout.cart.methods and / or checkout.cart.top_methods blocks by adding following code:


<block name="checkout.cart.methods" as="methods" type="core/text_list" translate="label">
    (...)
    <block type="amazonpayments/pay_button" name="checkout.cart.methods.amazonpayments_pay.bottom" before="-">
        <action method="setIdSuffix"><value>div</value></action>
        <action method="setEnableOr"><value>1</value></action>
    </block>
</block>
(...)
<block name="checkout.cart.top_methods" as="top_methods" type="core/text_list" translate="label">
    (...)
    <block type="amazonpayments/pay_button" name="checkout.cart.methods.amazonpayments_pay.top" before="-">
        <action method="setIdSuffix"><value>top</value></action>
        <action method="setEnableOr"><value>1</value></action>
    </block>
</block>










After upgrade to 3.x, when the buyer clicks Amazon Pay button in the cart, he is redirected to the customer dashboard instead of the checkout.


	Please make sure that your webserver serves the most recent version of the js/creativestyle/amazonpayments.min.js file. Some webservers (as well as CDNs) are caching static assets, so it may happen that your shop serves an outdated version of the frontend JS application.


	If you are using custom layout or template files for Amazon Pay, make sure that your customizations are compliant with the recent changes in the extension. The easiest way to check is your customization is the case is to delete following files as after refreshing Magento cache, see if this resolves your issue:





	app/design/frontend/CUSTOMPACKAGE/CUSTOMTHEME/layout/amazonpayments.xml


	app/design/frontend/CUSTOMPACKAGE/CUSTOMTHEME/template/creativestyle/amazonpayments/js.phtml


	app/design/frontend/CUSTOMPACKAGE/CUSTOMTHEME/template/creativestyle/amazonpayments/login/redirect.phtml








          

      

      

    

  

    
      
          
            
  
Warning

This extension is not maintained anymore. Please use Amazon Pay (Checkout v2) [https://amazon-pay.rtfd.io/] instead.




Troubleshooting

Before taking any action, please refer to the Frequently Asked Questions section, where many common issues have been already explained and solved.


Event logs

The Pay with Amazon extension provides a convenient logging system. It is disabled by default, but you can enable it in the extension settings, refer to the Enable logging section for more details.


Log files location

The Logger saves details concerning all exceptions, all API calls and all incoming IPN notifications that occurred within the Pay with Amazon extension scope. Logs are stored in CSV files in the following locations:


	exceptions logs:

var/log/amazonpayments/apa_exception.log



	API calls logs:

var/log/amazonpayments/apa_api.log



	IPN notifications logs:

var/log/amazonpayments/apa_ipn.log







Logs accessing

In case you encounter any issues and Frequently Asked Questions section didn’t help, you should review your logs in the next step. Logs can be accessed in two ways:


	Using creativestyle ‣ Pay with Amazon ‣ Log preview feature, where all logs are displayed on a convenient list with basic filtering options.


	By directly accessing (using FTP, SFTP or SSH, depending on your server configuration) the above files on your server. After the download you can open them with any CSV-capable application. The current log files can be also downloaded by pressing Download as CSV button on the logs list creativestyle ‣ Pay with Amazon ‣ Log preview in the Magento admin.






Logs rotating

All log files are rotated as soon as they exceed the size of 8 Megabytes, the old log file is renamed then to var/log/amazonpayments/apa_*.log.timestamp and a new empty file is created for storing the new log entries. The old log files are still accessible by direct access (FTP, SFTP or SSH) to var/log/amazonpayments folder on the server.




Contact support

If you haven’t found a solution for your problem and need to contact us directly, please submit a support ticket on http://creativeticket.de site.





          

      

      

    

  

    
      
          
            
  
Warning

This extension is not maintained anymore. Please use Amazon Pay (Checkout v2) [https://amazon-pay.rtfd.io/] instead.




Changelog


Version 3.0.20


Fixes


	Fix array to string conversion error in IPN logger







Version 3.0.18


Fixes


	Fix payment URLs in the declined payment emails







Version 3.0.16


Changes and improvements


	Make Amazon Pay overview URL dynamic in the declined payment email






Fixes


	Remove apostrophe from Alexa carrier codes CSV







Version 3.0.14


Improvements & changes


	Implemented Alexa Delivery Notifications






Fixes


	Fixed race condition issue for the IPN notifications overlapping with the authorization process


	Fixed bugs for ERP and manual authorization modes


	Stop closing order reference on partial capture







Version 3.0.12


Fixes


	Fixed Firefox redirect experience issue


	Fixed misbehaviour of the button in the mini cart widget on the product details page







Version 3.0.10


Fixes


	Fixed the empty-cart issue brought by SUPEE-11155 security patch and Magento CE 1.9.4.2, EE 1.14.4.2







Version 3.0.8


Improvements & changes


	Implemented JS versioning


	Added support for newsletter subscription in the checkout







Version 3.0.6


Fixes


	Fixed redirect URL issues for the redirect authentication experience







Version 3.0.2


Improvements & changes


	Implemented Amazon Pay Strong Customer Authentication (PSD2 compliance)







Version 2.0.28


Improvements & changes


	Improved button tooltip handling on mobile devices


	Explicitly set environment params for login JS application


	Re-structure settings page






Fixes


	Fixed reference to the closed cURL resource in Amazon Pay SDK lib


	Add support for form key validation in One Page Checkout







Version 2.0.26


Changes


	Stop keeping order reference ID and access token in the session data


	Force transaction data re-fetch on incoming IPN notification


	Re-implement Amazon Pay API requests logging






Fixes


	Add shipping rates recollecting after saving shipping address (fixes shipping costs issue)







Version 2.0.24


Fixes


	Fixed shipping address processing during the checkout







Version 2.0.22


Changes


	Revert APA deprecation (Make Client ID config option optional)







Version 2.0.20


Changes


	Make Client ID config option mandatory (APA deprecation)






Fixes


	Fixed non-working Amazon Pay button on the product page when Login is disabled







Version 2.0.18


Changes


	Splitted Eurozone region






Changes


	Wrap execution of external JS on checkout page in try-catch block






Fixes


	Fixed automatic invoice creation for auth & capture payment action


	Fixed typos in config options paths







Version 2.0.16.1


Fixes


	Fixed saving access key and secret key options issue







Version 2.0.16


Major Highlights


	Implemented support for One Page Checkout






Improvements


	Added support for SetOrderAttributes API call






Changes


	Updated Amazon Payments SDK library







Version 2.0.14


Improvements


	Enabled support for multi currency globally






Fixes


	Skip declined payment email sending for synchronous authorizations


	Fix JS to dispose security warning in Magento malware scanner







Version 2.0.12


Fixes


	Added missing translations for custom order statuses settings (#131)


	Re-authorization after InvalidPaymentMethod follows payment action settings (#133)


	Added order reference cancellation for asynchronous TransactionTimedOut authorization (#134)







Version 2.0.10


Improvements


	Added configurable order statuses for declined authorizations (#129)


	Implemented basic support for custom fields in the checkout






Fixes


	Fixed invoice status update on successful capture notification (#128)







Version 2.0.8


Improvements


	Added configurable multi currency






Fixes


	Fixed missing Refund online button for invoices created automatically for CaptureNow options (#127)


	Fixed TransactionTimedOut and AmazonRejected auth declines handling in synchronous mode







Version 2.0.6


Improvements


	Added support for soft descriptor in authorization call (#115)


	Added Amazon Pay button tooltip (#121)


	Implemented automatic order reference closing on successful capture (#126)


	Ignore authorization IPNs for synchronous mode (#120)






Fixes


	Fixed double invoice bug for manual capture (#122)







Version 2.0.4


Improvements


	Added Amazon Pay button on product view page






Fixes


	Fixed non-working Login for new customers







Version 2.0.2


Fixes


	Fix issues with wallet re-render for declined auth







Version 2.0.0


Major Highlights


	Implemented omni-chronous authorization






Changes


	Refactored order post-processing


	Changed IPN endpoint URL


	Changed frontend layout and templates (no backward compatibility)


	Simplified frontend JS application







Version 1.8.6


Improvements


	Added coupon code handling in Amazon checkout review


	Added possibility to disconnect customer account from Amazon account






Changes


	Removed password form for account matching when customer is logged-in


	Updated Amazon Pay logos in Magento admin






Fixes


	Fixed PHP versions in Magento Connect package.xml file







Version 1.8.4


Improvements


	Support for France, Italy and Spain


	Support for PHP 7


	Configurable store name in API calls






Changes


	Amazon Payments re-branding






Fixes


	Fixed legacy payment method bug when trying to list all payment methods


	Fixed missing original_price and base_original_price item’s attributes after order is placed


	Added missing return statement to the IPN controller







Version 1.8.2


Major Highlights


	Implemented Quick Configuration (Simple Path)






Improvements


	Added verbosity to error messages on frontend in sandbox mode


	Set payment method as soon as Amazon checkout is started






Fixes


	Fixed call to member function on null $quote variable in payment method model







Version 1.7.8


Improvements


	Implemented simplified partial capture






Changes


	Updated Amazon Payments SDK library






Fixes


	Added missing declined payment email templates for FR, IT and ES


	Fixed several issues for hard declined authorizations in synchronous mode







Version 1.7.6


Improvements


	Added support for custom SSL CA bundle file


	Implemented automatic authentication experience


	Disable Pay with Amazon availability for zero-total orders


	Retrieving billing address during the checkout


	Added exception handling for missing amazon_user_id attribute






Fixes


	Added support for SUPEE-6285 patch


	Added support for SUPEE-6788 patch


	Fixed calls to deprecated iconv functions in SDK library


	Fixed display errors for Magento RWD theme







Version 1.7.4.1


Fixes


	Fixed incorrect billing address issue for Auth & capture payment action







Version 1.7.4


Improvements


	Added missing payment cancellation functions


	Added Login with Amazon button on the customer registration page


	Added retrieving shipping address during the checkout


	Disabled Amazon button for virtual orders when Login is disabled






Fixes


	Fixed issue with placing virtual orders in sandbox mode


	Fixed closing order reference on completed capture







Version 1.7.2


Major Highlights


	Implemented multilanguage feature for Login with Amazon






Improvements


	Implemented re-authorization after the first authorization expires


	Putting order on hold for some kinds of closed authorization


	Added reason code of the transaction status directly to the order comments


	Added store name to SetOrderReferenceDetails call






Changes


	Updated Amazon Payments SDK library to 1.0.14






Fixes


	Fixed Firefox redirect experience issue


	Fixed issues in the splitting full customer name helper function







Version 1.6.4


Major Highlights


	Implemented redirect authentication experience






Improvements


	Added links to the seller credentials in Amazon Seller Central on extension settings page


	Added Amazon Seller Central order link on order preview page in Magento admin


	Added invoice cancellation on declined capture


	Modified way of identifying Place order button in the checkout based on button ID instead of container class name






Fixes


	Removed button tooltip for mobile devices


	Fixed missing re-authorization on declined authorization in Auth & capture payment mode







Version 1.6.2


Fixes


	Fixed bugs in the refactored payment method model


	Fixed IPN processing bugs in v.1.6.0


	Fixed 404 error when customer press Cancel on Amazon login form







Version 1.6.0


Major Highlights


	Implemented synchronous authorization






Improvements


	Made initial order status configurable


	Refactored payment method model







Version 1.3.4


Improvements


	Added gift messages support


	Improved customer address handling for Germany and Austria (extracting company name from the address)






Changes


	Switched IPN endpoint URL to non-secure mode if sandbox is enabled






Fixes


	Fixed missing original_price and base_original_price item’s attributes after order is placed


	Fixed state of Place order button which was enabled even the payment method is not selected


	Fixed state of Place order button which was disabled for virtual orders







Version 1.3.2


Major Highlights


	Implemented asynchronous way of loading Amazon Payments JS libraries






Improvements


	Added cURL error handling for Login with Amazon API calls






Changes


	Using deminified JS when sandbox mode is on for easier debugging


	Modified Pay with Amazon button tooltip text for virtual orders


	Refactored Amazon Payments SDK library to fix autoloader issues






Fixes


	Fixed wrong shipping cost when additional fees (acting as additional items in total section) are applied


	Fixed issue with Merge JS option enabled


	Closing OrderReference transaction after succesful capture







Version 1.2.6


Major Highlights


	Implemented responsive Amazon Payments widgets in the checkout






Fixes


	Fixed error when accessing extension settings page on Magento lower than 1.7.0.1


	Fixed issues with Magento compiler







Version 1.2.4


Fixes


	Fixed Pay with Amazon button appearing twice when Login with Amazon feature is enabled







Version 1.2.2


Major Highlights


	Added Login with Amazon service






Improvements


	Added helper methods for generating Pay or Login with Amazon buttons






Changes


	Changed frontend template files structure


	Changed Pay with Amazon button in the 1st step of OPC to Login with Amazon






Fixes


	Clean orderReferenceId session data after successful order


	Fixed issue with permanently disabled Place order button when there is more than one layer with buttons-set class used


	Fixed using of invalid Amazon account credentials when cancelling an order in non-default store of multi-store installations
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Migration to Amazon Pay (Checkout v2)

Amazon Payments provides a new payment service: Amazon Pay (Checkout v2), which resolves some of the issues introduced by PSD2 directive and brings some new features improving the buyer shopping experience. The following guide provides necessary information on how to migrate to the new Amazon Pay (Checkout v2) extension.


About Amazon Pay

Amazon Pay is an end-to-end payment solution that gives hundreds of millions of active Amazon customers a familiar, fast, and secure way to complete their purchase through your online store. Shoppers can use the address and payment information already stored in their Amazon account to check out - avoiding account creation or the need to re-enter their billing and shipping information. The performance is continually optimised by technology, learnings, and best practises from Amazon.


Key Benefits


	Reduce friction with a payment process that customers trust and can complete in minimal clicks


	Proactively notify customers when their order is on its way or has arrived with Amazon Alexa


	Rest assured with advanced fraud protection technology backed by Amazon


	Easily integrate Amazon Pay into your online store






Key Features


	PSD2 compliant: Built-in support for strong customer authentication as required under PSD2


	Delivery Notifications: Proactively alert customers on the arrival status of physical goods orders via Amazon Alexa


	Multi-currency: Maintain the local currency experience across the shopping journey and help customers avoid currency conversion fees from their credit card issuer or bank


	Amazon Sign-in: Reduce friction during account creation and sign-in by offering a fast and secure way for customers to authenticate through Amazon. Shoppers with an active Amazon account don’t need to login again


	Automatic Decline Handling: Reduce lost sales with a consistent experience for customers to gracefully recover from a declined payment


	Payment Protection Policy: Protection against fraud-related chargebacks (check User Agreement [https://pay.amazon.eu/help/201212430] for more details)


	Amazon Pay A-to-z Guarantee: Increase customer confidence to complete purchase in your online store with extra assurance on the timeliness of delivery and order quality







Pre-migration steps


	Create a backup of your shop before proceeding to install.


	If your shop is using compilation (you can check it in System ‣ Tools ‣ Compilation), disable it please before proceeding to install.






Getting the installation package

Go to Creativestyle Magento 1.x connect channel [https://connect.creativestyle.de/Creativestyle_AmazonCheckout] and download the recent installation package of the extension. Unpack the downloaded file to your Magento root directory.


Note

If you are using any VCS (git, svn, mercurial) for versioning your shop basecode, you can also commit the content of the downloaded file to the VCS repository and next deploy it to your shop.





Installation process

After unpacking the downloaded installation package to your Magento root directory, please login to Magento admin, go to System ‣ Cache Management and flush Magento cache storage. If you have disabled compiler in pre-installation stage, you can go now to System ‣ Tools ‣ Compilation, recompile and enable compiler again. Next, logout from the Magento admin and login again.



Activation

After the succesfull installation, you have to switch to the new payment service. If you have active previous Amazon Pay extension, the new one is disabled by default. To activate the new Amazon Pay (Checkout v2) go to creativestyle ‣ Amazon Pay and Login with Amazon ‣ Settings (or System ‣ Configuration ‣ Amazon Payments tab), on the top of the settings page you will find a control to switch between old Amazon Pay and the new one Amazon Pay (Checkout v2). Click Amazon Checkout v2 button to activate the new payment service.



Configuration

Amazon Pay (Checkout v2) extension for Magento 1.x provides automated settings migration routine. If your Amazon Pay extension for Magento 1.x is configured properly, most of your settings will be migrated automatically once you refresh the cache after the new extension installation. The following settings will be migrated from the previous Amazon Pay extension:


	Payment region


	Merchant ID


	Client ID


	Operation mode (live / sandbox)


	Payment action (authorize / authorize & capture)


	Display language


	Store name


	Soft descriptor




The only settings that require manual input are:


	Private key


	Public key ID




If you were using Alexa Delivery Notifications with the previous Amazon Pay, you should already have those settings, otherwise please login to Amazon Seller Central, generate new keys (or provide your own ones) and then paste Private key and assigned Public key ID to the appropriate input fields on the Amazon Checkout settings page.



Testing the new integration

After making sure that all settings are complete, you should test your installation. Only after successfully testing in the Sandbox mode you should switch to the live environment and make the button visible for all your sellers.

These tests should cover the different workflow that you encounter while processing orders. Both include the standard process like receiving an order, invoicing, shipment and alternative processes like canceling orders and refunding orders. Verify that all objects in your Magento admin are in the expected status and you correctly received all order information including the shipping address, contact details and the billing address (if applicable).

You should test also payment declines. To receive the complete testing scenarios contact Amazon Payments.
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You can now access your Amazon Seller account with MWS
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number CUNIESITEEIEY

AWS Access Key I KT —
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“If you are developing MWS Applications o otherwise providing MWS-related development services to other sellers, you will need to provide
this developer account number to those sellers so that they can authorise you to access their Amazon seller accounts with MWS.
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Important: Please follow these instructions or it will not be possible to activate your account.

Do you already have an Amazon.co.uk account, or would you like to resume a previous incomplete registration? Click here

What is your account informa

Business Name: [Testshop 123
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‘Amazon Payments Europe Acceptable Use Policy [V Yes, I have read and accepted the terms and conditions of the Policy





_images/prerequisites_screenshot_19.png
Orders Integration Reports Performance
—_—

Integration Central

MWS AccesSKey





_images/prerequisites_screenshot_191.png
amazon sellercentral  OrRDERS  INTEGRATION

euope

Login and Pay with Amazon Integration Settings

General Information

Seller ID

ABCDEFGH01234

MWS Account Information

Access Key ID

ABCDEFGHIKLMNOPQRST

Secret Access Key

Rate this page ~ Contact Seller Support

creativestyle GmbH  © 1999-2015 Amazon.com Inc. or its affilates

Amazon Payments - UK (:

Login with Amazon Account Information
Application Name

creativestyle GmbH

Client ID

amznt application-oa2-
client 500537 eadb80420d66b725910c3de529b4ct

Client Secret

‘Search

Q| Messages | Help | Settings

You're in Sandbox View ~

The Sandbox provides robust testing
capabiliies to ensure your integration is
properly configured. Leam more

Documentation ~

Helpful documents
Integration Guide
API Reference Guide

Help and FAQ ~

Frequently Asked Questions
Contact us





_static/up-pressed.png





_static/plus.png





